IMAGE IS EVERYTHING
**Typography**

**Font Size**
- Is Measured In: Points

**Font Families**
- Have style.

**Leading**
- Line spacing.

**Kerning**
- Is character spacing.

**Tracking**
- Is letter-spacing.

**Types of Type**
- Serif: Refers to the small lines that attach to the main strokes of font characters.

**Sans-serif:**
- Lacks serif details on characters. Sometimes called blockletters.

**Display or Novelty:**
- Unique fonts that are commonly used for headings and logos.

**Knockout/Overprint**
- Eliminating portions of a background image or color to create an effect.

**Type on Background Colors**
- 100% Black with white overprint type
- Dark green background with yellow-green type
- Medium yellow background with light yellow type
- Light purple background with purple type
- Red background with yellow type
- Black with white troweled type
- Yellow background with red type

---

**Advertising Measurements**

---

**Rop Breadcrumb: Column Widths**

<table>
<thead>
<tr>
<th>Column</th>
<th>Inch(es)</th>
<th>Picas</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 3/8</td>
<td>1/8</td>
</tr>
<tr>
<td>3</td>
<td>1 3/4</td>
<td>1/4</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>2/4</td>
</tr>
<tr>
<td>6</td>
<td>2 3/4</td>
<td>3/4</td>
</tr>
<tr>
<td>8</td>
<td>3 1/2</td>
<td>3/2</td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td>4/4</td>
</tr>
</tbody>
</table>

---

**Star Savings Breadcrumb: Column Widths**

<table>
<thead>
<tr>
<th>Column</th>
<th>Inch(es)</th>
<th>Picas</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 1/16</td>
<td>1/16</td>
</tr>
<tr>
<td>3</td>
<td>1 7/16</td>
<td>7/16</td>
</tr>
<tr>
<td>4</td>
<td>2 1/16</td>
<td>1/16</td>
</tr>
<tr>
<td>6</td>
<td>2 17/16</td>
<td>17/16</td>
</tr>
<tr>
<td>8</td>
<td>3 1/16</td>
<td>1/16</td>
</tr>
<tr>
<td>9</td>
<td>4 1/16</td>
<td>1/16</td>
</tr>
</tbody>
</table>

---

**Tabloid: Column Widths**

<table>
<thead>
<tr>
<th>Column</th>
<th>Inch(es)</th>
<th>Picas</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 3/4</td>
<td>3/4</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>2/2</td>
</tr>
<tr>
<td>4</td>
<td>2 3/4</td>
<td>7/8</td>
</tr>
<tr>
<td>6</td>
<td>3 1/2</td>
<td>4 1/2</td>
</tr>
<tr>
<td>8</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>9</td>
<td>4 1/2</td>
<td>2</td>
</tr>
</tbody>
</table>

---

**Overprinting**
- Makes the file easier to hold in register during the printing process.

**Display or Novelty:**
- AaBbCcDdEeFfGgHhIiJjKkLlMmNnOoPpQqRrSsTtUuVvWwXxYyZz

**Types of Type**
- *Note the difference in widths on double trucks between..."}

---

**��**

---

**InDesign Preferences**

- **Appearance of Black:**
- Make sure the Overprint Black is NOT checked. If it is, all black on the document will overprint.
At The Kansas City Star, we accept electronic ads created on Macintosh-compatible software to be placed in our print pagination system. Digital files bypass the need for scanning an image, ensuring the final printed version is of "original" quality. Ads suffer no second- or third-generation reproduction loss in the digital transfer. Before submitting digital material, please use the information in this publication to ensure your design applications are compatible with those in use at The Kansas City Star. Each system and each ad is different.

**Supported Apps and Formats**
Our preferred format is an Adobe Acrobat PDF, version 9 or below. We recommend using Adobe's "High Quality Print" PDF setting to create your file:
- All PDF files must have the fonts embedded.
- QuarkXPress 8.0 or later
- Adobe Illustrator Creative Suite [EPS]
- Adobe Photoshop Creative Suite [EPS or TIF]
- Adobe InDesign Creative Suite 2.6

**Applications with Limited Format Support**
We accept EPS file formats from the following programs in support applications. The Kansas City Star cannot edit these files. Therefore, if your file has changes after it has been submitted, you will need to provide a new EPS file:
- Macromedia Freehand [EPS]
- CorelDRAW [EPS]
- Adobe PageMaker [EPS]

**No Support**
If the application you are working in cannot create a PostScript, EPS or PDF file, it is not supported.

**Native Files**
Supporting files include all artwork and fonts that are used in the file. If you are working on a PC platform, The Kansas City Star will not be able to use your fonts. If it will be necessary to create a PDF, or send an EPS file with the type outlined.

**Preflight**
All digital files are preprocessed through a special queue which tests the files for compatibility with our print production system. Preflighting the files ensures they will process correctly. If there is a problem with the submitted file, you will be contacted and asked to resend a corrected version. Preflight also converts RGB to CMYK colors, which can cause the colors to change.

**Graphics**
We recommend all images and illustrations to be photographed in page layout programs at 100%. Downsizing larger files into a layout program increases copying, proofing and production times. Digital images ( raster) must be saved using EPS or TIFF formats. Do not save EPS files as JPEG or with JPEG encoding. EPS files should be saved as 8-bit TIFF with binary encoding.

**Ad Deadlines**
Please contact your advertising account executive or see the current rate card for our digital ad deadlines. Ads must be submitted on or before deadline in order for Ad Services to preflight test the digital file. We will not be accountable for production problems with ads submitted after the no-proof digital deadline.

**Color Modes**
Use bitmaps for line art, grayscale for black and white images and CMYK for color images. Never save an image using RGB mode and avoid duotones if possible. Save images with TIFF or EPS format. Vector-based art must be saved an EPS.

**Color Ads**
The Kansas City Star prints most custom or spot colors using four-color process. Color in electronic ads must be created in CMYK. The Kansas City Star recommends that separations be printed before submitting the file. This will help to ensure that the ad separates correctly. AVOID CREATING DUOTONE GRAPHICS. Please contact a member of Ad Services before submitting a duotone, as all duotone artwork will be converted to CMYK.

**Resolution and Line Screen**
The Kansas City Star outputs plates at 120 lpi and 1024 dpi. Before saving in Photoshop, make the resolution of all black and white, and color images 240 ppi (twice our line screen). Scanned line art or bitmap illustrations may be saved as high as 1200 ppi.

**First-Time Digital Advertisers**
If you will be sending a digital ad for the first time, please contact Ad Services at 816-234-4197 before sending your file. Ad Services will work with you to make sure that your file will process through our system correctly.

---

**MEDIA FERRY**

The Kansas City Star uses a web-based delivery portal called Media Ferry which can be accessed by visiting http://sw.expresskcs.com/konstatlive.

On the home page (left image) are two upload options:
- The "Job Material/Other Artwork Upload" option can be used for uploading multiple digital ads or ad materials. The limit on the upload is 256MB.
- The "Camera-ready Upload" option is for submitting a single, complete ad. This option will only accept a PDF file for upload. The file size must be less than 127MB. If you have completed a ad in a .tif format or multiple PDF files to upload, you will need to use the "Job Material" option.

**Upload artwork for use ad:**
- EPS, JPG, TIF, etc.

**Upload Camera Ready PDF files:**
- only File must be a PDF.

- The required fields have an asterisk next to them. The ad will not submit without filling in the required fields. You will get a prompt on any required fields that you are missing.

- Some of the fields will only accept alpha characters. The phone number field will only accept numeric characters. There are prompts to indicate this when you fill it out.

**Konstatlive**
Under the job materials option: Select "Attach More Files" when you have more than five pieces of material to submit for your ad.

---

**CONFIRMATION:**

- You will receive a message that your job has been submitted with the confirmation number (left image).

- A confirmation email will be sent to the customer and the Account Executive.

- If you encounter issues uploading to Media Ferry, please call our ad production team at 816-234-4197.
WHAT IS DOT GAIN?
Dot gain is an increase in the diameter of the halftone dot. When ink touches the paper it is absorbed slightly which causes the ink dot to spread and grow in size. Dot gain will always be present in offset printing. The Kansas City Star’s Direct-to-Plate technology reduces the press dot gain. The Star’s newer presses have a dot gain between 18%-22%. This is below the industry standard. When adjusting for dot gain it is important to understand not all dots grow at the same degree. The highest area of dot gain is in the mid-tone ranges (40%-60%).

COLOR GAMUTS
A color gamut is the subset of colors that can be accurately reproduced by certain output devices. A digital camera can capture more colors than what our press can reproduce. A properly calibrated monitor using The Star’s color profile will be applied once you open your image. If your image is RGB, the profile will be applied once you open your image. If your image is in CMYK, the profile will be applied once you open your image.

COLOR PROFILES
Color profiles help control color when an image travels from a computer monitor to the press and from an RGB color space to a CMYK color space. The RGB gamut, or possible range of colors, is larger than the CMYK gamut. All images that convert from RGB (digital photography) to CMYK (printing) need to reproduce successfully in a smaller color space. Color profiles ensure the most accurate color reproduction for a particular press.

A properly calibrated monitor using The Star’s recommended Color Settings will ensure your images print correctly. This profile can be downloaded by visiting www.KansasCity.com/display_advertising. If your image is RGB, the profile will be applied once you convert the file to CMYK.

TOTAL INK LIMIT
The Kansas City Star’s presses have a total ink limit of 220%. This means when all percentages of color are added up, it cannot exceed 220%. Also, the sum of the percentages of color in the darkest part of the image should be close to 220% so that it can be as rich as possible.

The Star’s color profile helps to adjust for this when converting to CMYK color mode. If you want to know how much the total ink limit is, go to Window > Info in Adobe Photoshop and use the eyedropper icon. You may have to go to the panel option to select “Total Ink.” This will show the total ink limit of the image at the spot where your cursor rests on the image.

RESOLUTION
It is important to understand the difference between ppi (pixels per inch), dpi (dots per inch) and lpi (lines per inch or line screen).

- ppi is based on how many pixels per inch an image is made up of. This is only for working on a computer.
- dpi is similar and is referred to both on screen (identical to ppi) and when printed at a halftone pattern by how many dots per inch can be printed on the paper. This is only for working on a computer.
- lpi is different by the measurement of how many lines or rows of dots can be printed in an inch. The Kansas City Star eliminates almost all press dot gain. It is recommended that an image’s resolution be at least twice the amount of the line screen. All images should be submitted with a resolution of 240 dpi. The images below illustrate the differences in the quality of the image based on its resolution. Note the 300dpi and the 240dpi are identical in quality. The press will not show a difference between the two resolutions because they both output at the same lpi. This allows you to send a 240dpi image which will save file size and decrease your time printing. However, anything below 350 dpi will print very poorly.

DIGITAL IMAGES & ARTWORK
Color Gamut is the subset of colors that can be accurately reproduced by certain output devices. A digital camera can capture more colors than what our press can reproduce. A properly calibrated monitor using The Star’s color profile will be applied once you open your image. If your image is RGB, the profile will be applied once you open your image. If your image is in CMYK, the profile will be applied once you open your image.

LOAD COLOR SETTINGS
The Kansas City Star uses a specific color setting profile to ensure quality images. This profile can be downloaded by visiting www.KansasCity.com/display_advertising.

After downloading the color profile, launch your Adobe Photoshop program. In the top menu, go to Edit and select Color Settings. Click on Load and browse to where the color setting was saved on your computer. Select the color setting and click OK.

This should be done before opening the image. If an image has a different profile already attached, the Embedded Profile Mismatch window may appear. Select Convert Document’s Color in working space. This will apply the color profile to the image. If your image is RGB, the profile will be applied once you convert the file to CMYK.

VECTOR ART VS RASTER ART
Vector graphics are composed of mathematical curves connected by points. Vector art can be enlarged and reduced without losing any of its integrity. This provides the flexibility to resize a graphic as much as is desired without sacrificing quality. Adobe Illustrator is a vector application. Raster graphics are composed of pixels. When enlarging a raster graphic, the pixels get bigger and you lose the nice edges. When working with a raster application, such as Adobe Photoshop, it is best to make the graphic the size that it will be used. If you create your raster graphic too small, you limit its capability of being enlarged.

This image doesn’t meet the total ink limit of 220%, so it will screen failed.

This image meets the total ink limit, so it can be printed being too dark.

Adobe Illustrator EPS scaled at 100%
Adobe Photoshop EPS scaled at 100%

Adobe Illustrator EPS scaled 150%
Adobe Photoshop EPS scaled 150%
**GRAYSCALE IMAGES**

The Kansas City Star’s state-of-the-art presses hold much better detail in the shadows and highlights of grayscale images. For good contrast in greyscales, we recommend adjusting the shadows (dark areas) to be 100% and the highlights (light areas) to be 0-1%. The midtones can then be adjusted to provide more detail.

In this example, we used Levels in Adobe Photoshop to make our adjustments. In Example A, we adjusted the shadows first. Option-click the black slider and move it to the right until image details begin to appear. With this preview, we not only see when we hit the maximum black percentage but also where these areas are. In Example B, we adjust the highlights by option-click on the white slider and move it to the left. Everything here that is white will print at 0%.

**COLOR IMAGES**

Any adjustments or color corrections should be done after the color profile has been loaded. The Kansas City Star’s Color Setting profile can be downloaded by visiting www.KansasCity.com/display_advertising.

The Star recommends adjusting images on a calibrated monitor. This is the best way to get an accurate representation of how your image will reproduce in the newspaper.

Use the Levels or Curves tools to adjust images in Adobe Photoshop. These are both located in the menu Image>Adjustments. It is not a good idea to use the auto versions of this tool because they may not adjust for the specific profile.

In this example we took a digital photo and adjusted it for The Kansas City Star’s press. When the profile was loaded, the image became lighter. This is normal.

**COLOR ADJUSTING EXAMPLE**

Almost all images need to be sharpened before they are printed, especially pictures shot with a digital camera. It is also helpful for photos that have a soft focus. The Unsharp Mask is located under Filter>Sharpen in Adobe Photoshop.

If you sharpen too much, a white “halo” effect will appear around the edges when the image is printed. Refer to the images at right for examples of no sharpening, good sharpening, and too much sharpening.

**TIP:** Always sharpen with 100% view of the image within Adobe Photoshop. This will allow you to see exactly what effect the Unsharp Mask is having on the image.
1. BORDER
How do we separate the ad from the surrounding type? With a border. Borders should complement the look of your ad and should never be the most prominent part of your ad. Straightforward and simple is best.

2. HEADLINE
Ad legend David Ogilvy once stated “The headline is a key part of the sales message; no matter how well the ad is presented, it can’t succeed if it is not read. If your headline does not include a selling message, you may be wasting 80% of your dollars.”

3. ILLUSTRATIONS
A highly effective way to draw the reader’s attention to an ad is with the illustration. Studies have shown that an ad with an illustration that takes up to 50% or more of the ad space increases readership by as much as 37%.

4. PRICE
Price is an important (and often dominant) element in a layout. Many local advertisers build their ads around the price. You can accent price by: (1) making it part of the heading, (2) making it the core the ad is built around, (3) placing it before the copy and (4) putting it in the test space.

5. SUBHEADLINES
Following the headline, you’ll have subheadlines that either clarify or amplify the thought in the headline. Subheadlines should be handled in much the same way as headlines, but are usually weighted somewhere between the body copy and the headline.

6. BODY COPY
Body copy develops and expands on the product benefits offered in the headline. The power of well-written advertising copy is proven by the billions of dollars of sales directly generated by great newspaper advertising. Copy should be written as though you were making friendly, personal conversation.

7. SIGNATURE
The signature is often a logotype. Though often used synonymously with a logo, signature means the name of the advertiser in any form and, unlike the logo, may change form from one ad to the next. Remember not to let the signature overpower other important aspects.

8. FOCAL POINT
You can establish this with a dominant headline, illustration or price.

9. CONCENTRATION
Another factor that affects eye appeal is concentration. This means grouping your selling points into display headings and test masses.

10. WHITE SPACE
Use as much white space as you can afford to use. It maximizes distraction and draws attention to what matters most.

11. COLOR
Try to achieve contrast in layout by effective use of different-sized type, bold type and color. If you can, fit color into your advertising budget. Introducing color increases impact.

12. ONE-SECOND TEST
The one-second test is a way of determining whether a reader can tell at a glance what the advertiser is selling. It simply means that you should be able to look at a layout for a second, then close your eyes and recall its sales message. If you didn’t get the message, you need to improve the layout.

13. CREATIVITY
If your ad is developed with simplicity, focal point and sequence in mind, it will appeal to the eye. However, some ads are more visually appealing than others. The difference is in creativity. Remember, creativity rarely occurs as a stroke of genius; it usually comes through persistent attempts and hard work.

Here are a few examples of ads that use all the elements. Through use of color to illustration, these ads will grab the attention of the reader.
By replacing antiquated presses with state-of-the-art, computer-controlled presses, The Kansas City Star leads the industry in high-quality newspaper publishing in North America. A machine of this type, KBA presses in use by The Star also print 100% of all North American currency and 90% of the world's currency. Our sleek modern glass building stands equivalent to eight stories tall allowing passers-by to view the printing process.

### Building

<table>
<thead>
<tr>
<th>Size</th>
<th>424,000 square feet, 3-story building with mezzanine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost</td>
<td>Approximately $200 million</td>
</tr>
</tbody>
</table>

**Packaging and Distribution**

<table>
<thead>
<tr>
<th>Size</th>
<th>80,000 square feet</th>
</tr>
</thead>
</table>

**Automated Palletizing System**

<table>
<thead>
<tr>
<th>Vendor</th>
<th>KBA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipment</td>
<td>4 KBA Commander Presses in two lines</td>
</tr>
<tr>
<td></td>
<td>Each press has nine towers and 10 reel stands</td>
</tr>
<tr>
<td></td>
<td>Automatic reel loading</td>
</tr>
<tr>
<td></td>
<td>Automatic blanket wash system</td>
</tr>
<tr>
<td></td>
<td>Four corrugated units</td>
</tr>
<tr>
<td></td>
<td>Two online stitching units</td>
</tr>
</tbody>
</table>

For more information, please refer to [The Kansas City Star](http://www.kansascitystar.com).